DIPLOMA IN FOOD AND BEVERAGE SERVICE

Eligibility: Senior Secondary (10+2) or equivalent.
Duration: One Year + six months in industry

Teaching hours per week: 35 Hours

Effective teaching: 34 weeks

Industrial training: 24 weeks after the annual examinations.

TEACHING AND EXAMINATION SCHEME

No. | Subject Subject Hours per Term
code week Marks*
THEORY
1 DFB-01 Food Service 5 100
2 DFB-02 | Beverage Service 5 100
3 DFB-03 | Food & Beverage Control 2 50
4 DCS-01 | Hygiene & Sanitation 2 50
5 DCS-03 | Business Communication 2 50
TOTAL 16 350
PRACTICAL
5 DFB-11 Food Service 8 100
6 DFB-12 | Beverage Service 8 100
7 DCS-11 | Computer Awareness 1 -
8 DCS-12 | Library 2 -
TOTAL 19 200
GRAND TOTAL 35 550

*Term Marks will comprise 30% Mid Term Marks & 70% End Term Exam Marks.

RULES AT A GLANCE

NO. TOPIC REQUIREMENT
1. Attendance required to become eligible for exam 75% in aggregate
2. Minimum pass marks for each theory subject 40%

3. Minimum pass marks for each practical subject 50%

4. Maximum duration to pass/clear all subjects/ papers 03 academic years

FOOD SERVICE (DFB-01)
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TIME ALLOTED: 05 HOURS PER WEEK

MAXIMUM MARKS: 100

ACTIVITY MAXIMUM MARKS
Marks for attendance 5
Mid-term exam marks 25
Total (Incourse Assessment Marks) 30
End term exam marks 70
Total 100

Learning objectives: This course shall take the learner through the basic concepts
of Food Service. At the end of this course the student shall be able to identify the
basic styles of service. Differentiate catering establishments, appreciate table laying
skills and methods used in the restaurant.
The course is planned for candidates to develop knowledge, inputs required at the
entry and supervisory level of a star hotel.

HOURS WEIGHTAGE
NS SIS ALLOTTED | FOR EXAM
1 Hospitality Industry and the waiter
e History of catering
e Catering establishments
e What professional waiters do 10 05%
differently
¢ Inter and intra departmental co-
operation
2 Classification and use of F&B Equipment
e Types, care and uses of Tableware,
Hollowware, Crockery, Glassware, 15 10%
Linen, Furniture and special Equipment
used in the F&B service department
3 The F&B Service department
e Staff organisation
e Duties and Responsibility of the waiter
e The Butler
> Role
» Special skills
» Duties
e Significance of a pantry 15 10%
» Layout
» Equipment
» Functions
» Silver polishing
e Outlets in a F&B Department-
Restaurant, Bar, Banquet, Poolside,
Coffee shop, Pastry shop,Night club
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4 Preparation for service

e Mise-en-place

e Mise-en-scene

e Rules of laying a table
e Basics of tray set up

15

10%

5 Menu and courses

e Types of menu

e Basic courses of a French Classical
Menu
Hors de oeuvre, Potage, Poisson,
Entrée, Relevee, Sorbet, Roti,
Legumes, Entremet, Savoury, Dessert,
Café

e Service, examples, cover,
accompaniments and sideboard
requirements for dishes from the above
courses

20

15%

MID TERM EXAM

6 Forms of service

Silver
American
Russian
Trolley

Buffet
Cafeteria
Family

QSR

English

Room Service

20

15%

7 Breakfast Service

e Cover, examples and menu and service
of
» Continental BF
» American BF
» English BF
» Indian BF
> Buffet

15

10%

8 Kitchen Stewarding

¢ Role
e Hierarchy
e Equipment

10

05%

9 Function Catering
e Banquets

15

10%
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> Types

» Seating

» Menu
Out Door Catering
Events

10

Specialised F&B Catering

Airline catering

Hospital catering

Cruise line catering

Railway Catering

Catering services in Armed forces
Welfare Catering

15

10%

TOTAL

150

100%

o
J L National Council for Hotel Management & Catering Technology, Noida.




BEVERAGE SERVICE (DFB-02)

TIME ALLOTED: 05 HOURS PER WEEK MAXIMUM MARKS: 100
ACTIVITY MAXIMUM MARKS
Marks for attendance 5
Mid-term exam marks 25
Total (Incourse Assessment Marks) 30
End term exam marks 70
Total 100

At the end of this course a student shall be able to:
e Define and classify different alcoholic and non-alcoholic beverages.
Differentiate different beverages on the menu.
Match wines with Indian & International food items.
Understand alcohol strength of drinks.
Understand effect of alcohol on human body.
Appreciate bar operations.

HOURS | WEIGHTAGE

UNIT SONISINE ALLOTTED | FOR EXAM

1 Non-alcoholic beverages

¢ Classification: Stimulating, Energizing,

Refreshing 10 05%
e Brands
e Service

2 Wines

Classification

Production

New world vs Old world wines
Grape varieties

Brand names 20 15%
Service of Red, white, sparkling wines
Aperitif wines: Service and popular
brands

e Fortified wines: Service and popular
brands

3 | Spirits

e Whisky, Rum, Gin, Vodka, Brandy,
Tequila 20 15%
» Classification

> Brands

» Service

4 Liqueurs

1 109
e Classification 0 0%
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Colour and flavour
Famous brands at least 10

Cocktails

Classification
Rules of making cocktails
Recipe of 20 classical cocktails

15

10%

MID TERM EXAM

Beer

Classification
Service
Storage
Brands

15

10%

Liquor

Alcohol and the human body
Strength of drinks
Pouring measure

15

10%

Bar

Layout

Permitted hours

Opening and closing duties
Age and Alcohol

Bar Frauds

Types

Responsible Service and trends

15

10%

Food and wine harmony

Matching wines with international menu

Matching wines with Indian menus

15

10%

10

Retail beverage outlets

Coffee baristas

Chai Bars

Pubs

Juice bars

Operations in FOH, MOH, BOH

15

10%

TOTAL

150

100%
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FOOD & BEVERAGE CONTROL (DFB-03)

TIME ALLOTED: 02 HOURS PER WEEK

MAXIMUM MARKS: 50

ACTIVITY MAXIMUM MARKS
Marks for attendance 2%
Mid-term exam marks 122
Total (Incourse Assessment Marks) 15
End term exam marks 35
Total 50

Learning objectives: To help students to understand the complexities of controlling
the Cost, Food & Beverage products, labour and revenue in Food & Beverage
operations and maximizing profit without sacrificing the quality or quantity of the food
or beverage which goes to the guest.

HOURS WEIGHTAGE

UNIT CONTENT ALLOTTED | FOR EXAM

1 Cost and Sales Concept

Introduction
Cost Concepts 06 10%
Sales Concepts

Cost to Sales Ratio: Cost Percent

2 Control Process

Introduction

Control

The Control Process
Control Systems
Cost Benefit Ratio

06 10%

3 Control Cycle

Purchasing
Receiving 09 15%
Storing
Issuing

4 Menu Engineering & Analysis

e Introduction
e Menu Engineering 09 15%
¢ Menu Analysis

MID TERM EXAM

5 Controlling Food Sales

e Introduction 08 15%
e The goals of sales control
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Optimizing the number of customers
Maximising the profit

Controlling Revenue

Revenue Control using manual means
Revenue Control using computers

Beverage Control

Beverage Purchasing-Receiving-
Storing — Issuing Control
Beverage Production Control
Inventory turnover

Beverage Sales Control

Guest Checks and Control

14

20%

Labour Control

Labour Cost Considerations
Establishing Performance Standards
SOP

Standard Staffing Requirements
Preparing job descriptions

Training Staff

Monitoring Performance

Taking Corrective action to address
discrepancies between standards and
performance

08

15%

TOTAL

60

100%
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HYGIENE AND SANITATION (DCS-01)

TIME ALLOTTED: 02 HOURS PER WEEK

MAXIMUM MARKS: 50

ACTIVITY MAXIMUM MARKS
Marks for attendance 2%
Mid-term exam marks 122
Total (Incourse Assessment Marks) 15
End term exam marks 35
Total 50

LEARNING OBJECTIVES: After completion of the subject a student will be able to:

ARl ol

Understand Food Microbiology, Food Contamination and Spoilage;

Follow sanitary procedure during food handling;
Understand the importance of personal hygiene
Analyse critical control points; and

Practice laws governing the food safety and standards

No

CONTENT

TIME WEIGHTAGE
ALLOTTED | FOR EXAM

FOOD MICROBIOLOGY

e Introduction
e Microorganism groups important in food
microbiology
- Viruses
- Bacteria
- Fungi (Yeast &Molds)
- Algae
- Parasites
e Factors affecting the growth of microbes
e Beneficial role of Microorganisms

10 15%

FOOD CONTAMINATION AND SPOILAGE
¢ Classification Of Food
¢ Contamination And Cross
Contamination
e Spoilages Of Various Food With The
Storing Method

05 10%

SANITARY PROCEDURE FOLLOWED DURINC
FOOD HANDLING
e Receiving,
e Storage,
e Preparation,
e Cooking,

e Holding, and

10 20%
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e Service Of The Food

MID TERM EXAM

SAFE FOOD HANDLER
e Personal Hygiene discussing all the
standard.
e Hand Washing Procedure
o First Aid definition, types of cuts,
wounds, lacerations with reasons and
precautions.

10

15%

HAZARD ANALYSIS CRITICAL CONTROL
POINT

e Introduction to HACCP

e History

e Principles of HACCP

10

15%

FOOD SAFETY STANDARDS AUTHORITY
OF INDIA (FSSAI)

¢ Introduction to FSSAI

¢ Role of FSSAI

e FSSAI Compliance

05

15%

GARBAGE DISPOSAL
e Different Methods
e Advantages and disadvantages
¢ Municipal Laws and Swachh Abhiyan

10

10%

Total

60

100%
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BUSINESS COMMUNICATION (DCS-03)

TIME ALLOTTED: 02 HOURS PER WEEK MAXIMUM MARKS: 50
ACTIVITY MAXIMUM MARKS
Marks for attendance 2%
Mid-term exam marks 12 %
Total (Incourse Assessment Marks) 15
End term exam marks 35
Total 50

LEARNING OBJECTIVES:

Knowledge

1. Understand the fundamental principles of effective business communication
2. ldentify different forms of communication

3. Evaluate the difference between the types of communication

4. Understand the concept of body language and its correct use

Competencies

5. Apply effective communication in today’s business world

6. Use correct form of communication depending on business situation and
circumstances

Organise ideas and express in writing and speaking

Participate effectively in groups with emphasis on listening, critical and
reflective thinking and responding

9. Avoid common body language mistakes

© N

Mindset

10. Understand the importance of specifying audience and purpose, and to
select appropriate communication choices

TIME WEIGHTAGE

No CONTENT ALLOTTED | FOR EXAM
1 Introduction to Business Communication

e Definition

e Objectives 10 20%

e Principles of effective communication

e Importance of good communication
2 | Types of communication

e Formal 05 10%

e Informal

e Verbal
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e Written
e Horizontal
e Vertical

Essentials of good business letter and
types of letters — Official, D.O

05

15%

Letter writing

e Circular
Memo
Notice
U.O. Note
Applications
Bio-data (C.V.)
Covering letter
Invitations
Greetings
Apologies

10

20%

MID TERM EXAM

Communication with guest and Body
language

o Effective Speaking — Polite and
effective enquiries & responses,
Addressing a group

e Listening and note taking skills

¢ Body language- Importance &
application

10

15%

Speech Improvement

Pronunciation, stress, accent
Importance of speech in hotels
Common phonetic difficulties
Connective drills exercises
Introduction to frequently used foreign
sounds

10

10%

Electronic modes of communication:

Use of telephone

Taking telephonic orders
Telephone etiquette’s
Fax

E-mail and protocol
Responsible social media

10

10%

TOTAL

60

100%
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FOOD SERVICE PRACTICAL (DFB-11)

TIME ALLOTED: 08 HOURS PER WEEK MAXIMUM MARKS: 100
ACTIVITY MAXIMUM MARKS

Marks for attendance 5

Mid-term exam marks 25

Total (Incourse Assessment Marks) 30

End term exam marks 70

Total 100

Learning Objective: - This course is envisaged to develop skills related to
professional food service in aspiring candidates. At the end of this course a student
shall be able to.

1. Explain different types of F&B equipment
2. Handle and maintain equipment according to accepted standards
3. Deliver quality food service in the training restaurant.

UNIT CONTENT HOURS
ALLOTTED
1 Familiarization with F&B Equipment 20
2 ¢ Importance of sanitation and hygiene
e Care, cleaning and polishing of F&B equipment
e Mise-en-place and mise-en-scene for different 25
meal periods
e Pantry preparations and service
3 e Laying and relaying of table cloth
e Napkin folding 25
4 ¢ Handling of service spoon and service fork
e Water service
e Service using trays and salvers o5
e Silver service
e Clearance
5 e Laying and service of special Table d’héte menu
e Laying and service of breakfast set up on trays 25
MID TERM EXAM
6 e Service Sequence- Greeting, seating, order
taking, serving and bill presenting 40
e Briefing and de briefing
7 ¢ Organizing buffets
e Banquet seating plan practice 30

o
J L National Council for Hotel Management & Catering Technology, Noida. 13




8 e Service of Indian food

e QSR service 20
9 | Silver polishing 15
10 | Bussing and segregating waste at the dish wash 15
Total 240
Marking scheme for Examination
Food Service Practical (DFB-11)
Maximum Marks 100 Pass Marks 50

Part ‘A’ 25 Marks

MARKS
1. Uniform & Grooming : 05
2. Journal : 10
3. Viva : 10
Total : 25

Part ‘B’ (75 Marks)
Marks

a) Mise-en-place : 20
b) Service Efficiency : 20
c) Silver service skills : 20
d) Menu knowledge : 15
Total : 75

NOTE:

1. The examination should test skills and knowledge of the students by
assigning sets of tasks as listed in the practical syllabus under each category.

2. During table service each guest should pose one question to the candidate on
the item being served. The invigilators can brief guests prior to service.
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BEVERAGE SERVICE PRACTICAL (DFB-12)

TIME ALLOTED: 08 HOURS PER WEEK MAXIMUM MARKS: 100
ACTIVITY MAXIMUM MARKS

Marks for attendance 5

Mid-term exam marks 25

Total (Incourse Assessment Marks) 30

End term exam marks 70

Total 100

Learning Objectives: At the end of this course a candidate shall be able to;
1. Use different types of glassware to serve different alcoholic and Non -
alcoholic beverages.

2. Prepare cocktails according to accepted standards.
3. Render different type of beverage service as per SOP.
4. Practice responsible service of liquor.
5. Do formal banquet arrangements
UNIT CONTENT HOURS
ALLOTTED
1 e Service of Tea and coffee
e Service of Non-alcoholic beverages
e Serving from the coffee machine 25
e Service of coffee variations
2 e Wine service — Service of Table wines,
Sparkling wine, Aromatized wines and Fortified
wines. 30
e Food and wine harmony
¢ Wine appreciation
3 e Service of hard liquors
e Service of liqueurs 25
4 Preparation and service of classical cocktails 20
5 | Service of different types of beer 20
MID TERM EXAM
6 Raising of toast and setting up formal banquet 30
arrangements
7 | Settingup a bar 30
8 Preparation of garnishes and mixes for the bar 20
9 | Storage of wines, beer and spirits 20
10 | Responsible Service of Liquor
e Preventing trouble 20
e Complaints and Refusal of Service
e Potential Problem Situations
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e Reacting to Trouble
e Recording Incidents

Total 240

MARKING SCHEME FOR EXAMINATION
BEVERAGE SERVICE PRACTICAL (DFB-12)

Maximum Marks 100 Pass Marks 50

Part ‘A’ 20 Marks

MARKS
1. Uniform & Grooming ; 05
2. Journal : 10
3. Viva : 10
Total : 25

Part ‘B’ 75 Marks
Marks

a) Mise-en-place : 20
b) Service of tea/coffee : 20
c) Service of wine/beer : 15
d) Service of hard liquor/cocktails : 20
Total : 75

Note:-

1. The examination should test skills and knowledge of the students by
assigning sets of tasks as listed in the practical syllabus under each category.

2. The student must ensure that sideboard contains everything necessary for
service.

3. During table service each guest should pose one question to the candidate on
the item being served. The invigilators can brief guests prior to service.
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TIME ALLOTTED: 01 HOURS PER WEEK

COMPUTER AWARENESS (DCS-11)

MAXIMUM MARKS: Nil

Learning Objectives:- After the completion of Computer Awareness subject, the
Students will be able to:

1. Understand computer and its hardware & software.
2. To produce word document with proper for matting
3. To work on an excel sheet with basic functions.
4. Brows on net and communicate through e-mail
5. Prepare small power point presentations.
HOURS
UNIT CONTENT ALLOTTED
1 KNOWING COMPUTER
e What is computer?
» Basic Applications of Computer
e Components of Computer System
» Central Processing Unit
» Keyboard, mouse and VDU
» Other Input devices
» Other Output devices
» Computer Memory
o Concept of Hardware and Software
» Hardware
» Software 4
% Application Software
% Systems software
e Concept of computing, data and information
e Applications of IECT
» e-governance
» Entertainment
e Bringing computer to life
» Connecting keyboard, mouse, monitor and
printer to CPU
» Checking power supply
OPERATING COMPUTER USING GUI BASED
OPERATING SYSTEM
e Basics of Operating System
» Operating system
» Basics of popular operating system (LINUX,
WINDOWS)
e The User Interface 4
» Task Bar
» lcons
» Menu

» Running an Application
e Operating System Simple Setting
» Changing System Date And Time
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Changing Display Properties
To Add Or Remove A Windows Component
Changing Mouse Properties
Adding and removing Printers
¢ File and Directory Management

» Creating and renaming of files and
directories

YVVY

UNDERSTANDING WORD PROCESSING
e Word Processing Basics
» Opening Word Processing
» Menu Bar
» Using The Help
» Using The Icons Below Menu Bar
¢ Opening and closing Documents
» Opening Documents
» Save and Save as
» Page Setup
» Print Preview
» Printing of Documents
e Text Creation and manipulation
Document Creation
Editing Text
Text Selection
Cut, Copy and Paste
Spell check
Thesaurus
ormatting the Text
Font and Size selection
Alignment of Text
Paragraph Indenting
Bullets and Numbering
Changing case
e Table Manipulation
» Draw Table
» Changing cell width and height
» Alignment of Text in cell
» Delete / Insertion of row and column
» Border and shading

TMTVVVVVYVY

VVVYY

USING SPREAD SHEET

e Elements of Electronic Spread Sheet
» Opening of Spread Sheet
» Addressing of Cells
» Printing of Spread Sheet
» Saving Workbooks

e Manipulation of Cells
» Entering Text, Numbers and Dates
» Creating Text, Number and Date Series
» Editing Worksheet Data
» Inserting and Deleting Rows, Column
» Changing Cell Height and Width

e Formulas and Function
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» Using Formulas
» Function

INTRODUCTION TO INTERNET, WWW AND WEB
BROWSERS

Basic of Computer Networks

» Local Area Network (LAN)

» Wide Area Network (WAN)
Internet

» Concept of Internet

» Applications of Internet

» Connecting to the Internet

» Troubleshooting

World Wide Web (WWW)

Web Browsing Software

» Popular Web Browsing software
Search Engines

Popular Search Engines / Search for content
Accessing Web Browser

Using Favourites Folder
Downloading Web Pages
Printing Web Pages
Understanding URL

Surfing the web

Using e-governance website

VVVYY

COMMUNICATIONS AND COLLABORATION

Basics of E-mail

» What is an Electronic Mail

Using E-mails

Opening Email account

Mailbox: Inbox and Outbox
Creating and Sending a new E-mail
Replying to an E-mail message
Forwarding an E-mail message
Sorting and Searching emails
Document collaboration

Instant Messaging and Collaboration
» Using Instant messaging

» Instant messaging providers

» Netiquettes

VVVYYY

MAKING SMALL PRESENTATIONS

Basics

» Using PowerPoint

» Opening A PowerPoint Presentation

» Saving A Presentation

Creation of Presentation

» Creating a Presentation Using a Template

» Creating a Blank Presentation

» Entering and Editing Text

» Inserting And Deleting Slides in a
Presentation

o
J L National Council for Hotel Management & Catering Technology, Noida.

19




Preparation of Slides

» Inserting Word Table or An Excel Worksheet
» Adding Clip Art Pictures

» Inserting Other Objects

» Resizing and Scaling an Object
Presentation of Slides

» Viewing A Presentation

» Choosing a Set Up for Presentation
» Printing Slides And Hand-outs
Slide Show

» Running a Slide Show

» Transition and Slide Timings

» Automating a Slide Show

30
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